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Building a Basic Course in Blackboard 
An online workshop for Durham Tech faculty 

 
Purpose of this workshop: 

To walk you through the steps of posting course materials in Blackboard (Bb) and 
readying your course site for student use. 
 
Estimated time to complete: 

2 to 3 hours (You can stop and start whenever you want, and spend as much or as little 
time as you like!) 
 
What you will need: 

� Access to the Internet 
� Your Blackboard login information (provided in the "Intro to Bb" workshop) 
� A blank course in Blackboard (we have already created this for you.) 
� Documents for your course--such as a syllabus, handouts, PowerPoint 

presentations, etc.--that you have previously prepared and saved. 

Note:  If you haven't prepared these documents for your course yet, you should probably do that 
before beginning this workshop.  Otherwise, you can use this workshop to practice and become 
familiar with Bb but not to build a "real" course. 

 
What this online workshop covers: 

� Accessing the instructor's "Control Panel" and moving around in it 
� Posting documents in your course  

(such as syllabus, handouts, or PowerPoint presentations) 
� Posting links to web sites 
� Posting instructor contact information 
� Making folders and adding content inside them 
� Posting announcements 
� Customizing the course menu 
 
Blackboard has dozens of features that allow you to put course materials on the web 
and to interact online with your students.  You can select which features you want to 
use (and how you want to use them) to build a course site that is as unique as your 
teaching style and that supports your instructional goals. 
 
What this workshop does NOT cover: 

There are many Blackboard features and tools that will NOT be covered here.  For 
example, this workshop will not cover… 
� Using the Discussion Board 
� Sending email to students through Bb 
� Creating online tests 
� Posting grades (or using the grade book) 
� Groups 
 
 
 

For more info about Blackboard training, visit: 
http://courses.durhamtech.edu/wiki/index.php/Blackboard_Training 

 
Or, if you are the "self-study" type, you can access step-by-
step instructions on many topics here: 
http://courses.durhamtech.edu/wiki/index.php/Handouts 
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How to get started: 
Follow the instructions on the pages that follow.  Below is an overview of the steps you 
will need to complete. 
 

Note:  The steps marked with an asterisk ( * ) are required in order to receive credit for 
completing this workshop.   We recommend that you complete all the other steps as 
well! 
 

* STEP 1: Learn how to navigate in your course shell  pages 3 - 4 
  (estimated time: 15 minutes) 
 

* STEP 2: Post a syllabus  pages 5 - 7 
  (estimated time: 30 minutes) 
 
 STEP 3: Post a handout or PowerPoint presentation  pages 8 - 9 
  (estimated time: 15 minutes) 
 
 STEP 4: Post a web link  pages 10 - 11 
  (estimated time: 15 minutes) 
 

* STEP 5: Post instructor contact information  page 12 
  (estimated time: 10 minutes) 
 
 STEP 6: Make folders and put content inside them  pages 13 - 16 
  (estimated time: 30 minutes) 
 

* STEP 7: Post an announcement  pages 17 - 18 
  (estimated time: 10 minutes) 
 

* STEP 8: Customize your course menu  pages 19 - 21 
  (estimated time: 20 minutes) 
 

* STEP 9: Prepare a course for student use  page 22 - 23 
  (estimated time: 30 minutes) 
 

* STEP 10: Email us to let us know you're done!  page 24 
  (estimated time: 5 minutes) 
 
If you have questions: 
You can contact the workshop facilitator, Susan Horton, at hortons@durhamtech.edu or 
919-536-7213 X5902. 
 
 

Now, continue on to page 3 and let's get started… 
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STEP 1:  Learn how to navigate in your course shell (REQUIRED) 

 
Log in to Blackboard (at http://blackboard.durhamtech.edu/).  

 
You should know how to do this from the "Intro to Blackboard" workshop.  (If you have problems 
logging in, please refer to your documents from that workshop.  If you still can't log in, contact 
Instructional Computing at bbadmin@courses.durhamtech.edu 
 
A course has been created for your use in this workshop.  Once you log in, you should see this course 
listed under "Courses you are teaching".  (We will refer to this course as "your course" from now on.) 

 

Click on your course title to enter the course. 
 

Now you are in your blank course.  You are seeing the course from the "student view".  The first thing a 
student sees when entering your course is the Course Menu on the left (green panel) and the 
Announcements section on the right (which is empty at the moment). 
 
Your course has a "Control Panel" that only the instructor can access.  The Control Panel is where the 
instructor adds materials and manages the course.  I think of it as the "back stage" area, where the 
instructor sets things up. 

 
Click on the link to the "Control Panel" (the last menu item on the left). 
 

Take a moment to look over the options in the Control Panel.   
 
Notice how the Control Panel is organized into six sections.  One section you will use often is "Content Areas" 
(upper left).  You will learn more about these options as you proceed through this workshop.   
 

 
 

 
 

 
 
 
 
 
 
 
 

You will go into the Control Panel often to add new things to your course or to make changes.   
After adding something or making a change in the Control Panel, it is important to return to the 
"student view" to see how things will look to your students. 

Content Areas: This area provides tools to add text, 
handouts, PowerPoint presentations and other 
information into your course. 

User Management: This area 
provides tools for the instructor 
to manage users. 

Course Tools: This area contains 
communication tools for instructors to post 
announcements, send email, create and 
manage discussion boards, etc. 

Course Options: In this area, you can  
customize your course menu and make 
your course "available" to your students. 

 

Assessment: This area provides 
tools for building online tests, 
recording grades, and tracking  
user activity. 

Support: This area 
offers a link to an online 
instructor's manual. 
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To return to the "student view" of your course: 

Click on your course title in the "bread crumb trail" at the top of the Control Panel: 
 

 
 
About the Bread Crumb Trail 

� The "bread crumb trail" is a tiny horizontal menu (in a thin gray bar) above the Control Panel.   

� As you move deeper into the Control Panel, the bread crumb trail grows and shows you where 
you are, along with a "trail" of how you got there.  

� The bread crumb trail provides just about the only way to return to the "student view" (or front 
end) of your course. 

� As you use the Control Panel more, you'll find that you can use the bread crumb trail to "leap 
frog" from one area to another quickly. 

 
 

 
 
 

 
HANDS-ON PRACTICE 
 
Repeat the tasks listed below until you feel very comfortable doing them: 

� Log in to Blackboard. 

� Go into your course. 

� Go into the Control Panel. 

� Click on several items in the Control Panel to see what's there.  Spend a few minutes 
exploring and becoming familiar with where things are located. 

� Click on your course title in the bread crumb trail to return to the student view.

IMPORTANT:  In Blackboard, it is generally NOT advisable to use the browser's "Back" button.  
(At times, you may get a nasty error message if you do.)  Instead, learn to rely on the "bread 
crumb trail" and other links within Blackboard to move around. 
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STEP 2:  Post a syllabus in Blackboard (REQUIRED) 

 
This tutorial assumes that you have already used a word processor to create and save a 
syllabus.   
 
Before you get started: 
 
� Open your syllabus in your word processor.  Make sure it is complete and up-to-date.  

Save. 
 
� Now save your syllabus in rich text format (RTF).   

o What is 'rich text format' (and why should I use it)? 

 When you attach a document in Bb that was created in a word processor, your students will need a 
compatible word processor in order to open the document.   

 Since you can't predict what word processor your students will have, it is best to save your 
document in a format that can be opened by ANY word processor.   

 Saving in Rich Text Format (RTF) preserves formatting (such as bold, italics, bullets, numbering, 
tabs, tables, etc.) AND allows the document to be opened in any word processor. 

o How do I save my document in rich text format? 

 In Microsoft Word, choose File > Save As.  At the bottom of the dialog box, you will see the file 
name, and below it, "Save as type".  From the drop-down menu, choose "Rich Text Format".  The 
file ending will change from DOC to RTF.  Click SAVE. 

o Important note about file names 

 When saving a document that you plan to attach in Bb, do NOT use any special symbols in the file 
name (such as:  #   $   @   *  &  ?  and so on).  The file name CAN contain letters, numbers, 
spaces, hyphens and underscore marks.   

o How do I set Windows to show file extensions (so I can see which files are RTF)? 

 By default, Windows hides the file extensions (3 letter endings of file names).  It is very helpful to 
see these file endings in order to distinguish documents saved in Word format (.doc ending) from 
documents saved in rich text format (.rtf ending).   

 Follow these steps to set Windows to show file endings: 
1. In Windows, open "My Computer".   
2. From the Tools menu, choose Folder Options.  Click the View tab. 
3. Un-check the box beside "Hide file extensions for known file types".   
4. Click Apply, then click OK.  Close the "My Computer" window. 

 

In Blackboard, follow these steps to create an "item" and attach your syllabus: 

1. Go into your blank course on Blackboard 

2. Click on Control Panel, then click on "Course Information" (in the upper left area). 

3. Click on "Add Item" in the tool bar. 

 

(continued on next page) 
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4. Enter a name for the item.  Type your own descriptive title in the blank box provided: 

 
 

5. In the text box, you can type in a brief description if you want (optional): 

 

6. Scroll down to section 2 and click the BROWSE button.  Locate the RTF version of 
your syllabus on your computer and open it. 

 

 

 

 

 

7. For now, I recommend that you skip over all other options on this page.  Scroll down 
to the bottom and click SUBMIT. 

8. You will see a "receipt" that lets you know that your item was saved.  Click OK.   
 
Now your syllabus is posted in Blackboard! 
 
 
After posting an item, it is a VERY good idea to see what it looks like to students: 

1. In the bread crumb trail, click on your course title to return to the "student view". 

 

2. Click on the "Course Information" link in the menu.  On the right, you'll see the item 
you created, which contains a link to the syllabus.   

� Students can click the link to view the syllabus.  

� Or they can right-click the link and choose "Save target as" (or "Save link as") to 
save a copy to their hard drive for later viewing. 

 
Please see the next page to learn how 

to make changes to your syllabus AFTER posting it… 
After you have posted your syllabus in Blackboard, you may find later that you need to 
make changes to it (or make a correction).    

type your item name here! 
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You cannot make changes to the syllabus in Blackboard. Instead, you have to make the 
changes to your original document using your word processor, save, and then post the 
corrected document in Blackboard. 

Refer to the steps below whenever you need to make a change to your syllabus (or 
any document) you have posted in Blackboard. 
 
To make changes to a document after it has been posted in Blackboard: 

1. On your computer, open your word processor and then open your syllabus (or other 
document).  Be sure to open the most recent copy---preferably, the RTF copy. 

2. To avoid confusion, I usually choose File > Save As and then modify the file name to indicate 
that this is a revised copy.   

3. Make any needed changes and save.  (Be sure to save as file type RTF.  This should happen 
automatically if you opened the RTF copy to begin with.)  When finished, exit your word 
processor. 

4. In Blackboard, go to the Control Panel and into the Content Area where the document is posted.     

5. To the right of the item that contains the attached syllabus (or other document), click MODIFY. 

6. Scroll down to section 2.  Under "Currently Attached Files", you'll see your attached document:  

 

7. Click on REMOVE (and then OK) to delete the attachment. 

8. Now attach the revised document: 

a. Under section 2, click on the Browse button 

b. Locate and select ("open") the revised document 

9. Scroll down and click SUBMIT, then click OK. 
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STEP 3:  Post a handout or PowerPoint presentation 

 
This tutorial assumes that you have already created and saved a course handout OR 
PowerPoint presentation. 
 
Before you get started: 
� If posting a handout, save it first in RTF format.  (See Step 2) 
 
Follow these steps to create a Blackboard item and to attach a handout or 
PowerPoint presentation: 

1. Go into your course on Blackboard. 

2. Click on Control Panel, then click on "Course Documents" (in the upper left area). 

3. Click on "Add Item" in the tool bar. 

4. Type in a name for the item.  I recommend a descriptive title such as the following: 

Circulatory System Presentation (2-17-07) 

 - or -   

Aug 17 Lecture Notes 

…or whatever you think is appropriate! 

5. In the text box, you can type in a brief description if you want (optional). 

6. Scroll down to section 2 and click the BROWSE button.  Locate your handout (RTF 
version) or your PowerPoint presentation and open it. 

7. Scroll down to the bottom and click SUBMIT. 

8. You will see a "receipt" that lets you know that your item was saved.  Click OK.   
 
Now your handout or presentation is posted in Blackboard! 
 
Note:  If you want to post an additional handout or presentation on the same item,  
click "Modify" beside the item, scroll down to section 2, attach the document, and click 
Submit.  (Alternatively, you can create a new item and attach the document there.) 
 
Using the bread crumb trail, go to the "student view" and see what the handout or 
presentation will look like to students.  Click the link to see how the handout or 
presentation displays. 
 
 

Please see the next page for important notes about PowerPoint and Blackboard 

Note:  The steps listed below are very similar to the steps you followed for posting a syllabus 
in Step 2.  If you need more detailed instructions, refer to Step 2. 
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Notes about PowerPoint and Blackboard  
 
To view a presentation posted in Blackboard, the student must have PowerPoint ~OR~ the free 
PowerPoint viewer installed on his or her computer.   

 
Instructors should try to avoid posting very large PowerPoint presentations in Blackboard.   

� When a student clicks the link to your PowerPoint presentation in Blackboard, the entire presentation 
must download before the student can see it.   

� If the presentation is large (filled with lots of photos, particularly ones that haven't been resized or 
compressed in a graphics editor), then the student may have to wait a very, very long time before 
anything happens.  Many students will assume that their computers have locked up… 

� After you have posted a PowerPoint presentation (or any attached document) in Blackboard, you can 
see the size displayed in Blackboard: 

 
 

� As a general guideline, I would consider files over 2 MB (2 million or 2000000 Bytes) to be "too large" for 
students with slow connections to access. 

� Consider breaking large PowerPoint presentations into several smaller presentations before posting in 
Blackboard.  (You might also consider learning to use a graphics editor to optimize graphics for online 
viewing.) 

 

Note:  If you need to make a change to a handout or PowerPoint presentation after 
attaching it in Blackboard, follow the steps on page 7. 

 

Free PowerPoint Viewer 

For more info about downloading the free PowerPoint viewer, click here: 

http://courses.durhamtech.edu/wiki/index.php/PowerPoint_presentations_%26_Blackboard 
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STEP 4:  Post a link to a web site 

 
In Blackboard, it's easy to create a list of links to other web sites.  You can put the links all 
together in one section of the course ("External Links").  Or, you can add a link almost 
anywhere in the course.   
 
This tutorial will walk you through creating one link in the External Links area of your 
course.  You can then add more if you want, or create links in other areas of your course.  
 
Before you get started: 
� Think of a web site that would be a useful reference for your students.  You'll need 

the full and exact address of the web site for this tutorial.   
� If you can't think of a web site you want to use, you can make a link to the web site for 

Durham Tech's Library:  http://www.durhamtech.edu/library.htm 
 
Follow these steps to create a link in your Blackboard course to another web site: 

1. In the Control Panel, click on "External Links" (in the upper left area). 

2. In the tool bar, click "External Link" 

3. Type in a name for the item.  This can be any name that identifies the site, such as: 

Durham Tech Library 

4. In the "URL" box, type in the full and exact address of the web site you want to create 
a link to.  Be sure to include   http://   at the beginning. 

RECOMMENDED ALTERNATIVE:   
Instead of typing the address (and risking a typo), follow these steps to copy/paste the web 
address accurately into Blackboard: 

a. Minimize the Blackboard window so you can see the desktop.  (Don't exit Blackboard---you'll 
be coming back soon.) 

b. Start a second web browser (by double-clicking the Internet Explorer icon on your desktop or 
selecting a browser from Start menu > Programs) 

c. In this browser window, navigate to the web page you want to create a link to.  (Use your 
bookmarks/favorites, search through Google, type the address---however you normally 
access the site). 

d. Once you are viewing the web page that you want to create a link to, click your mouse one 
time in the address bar to highlight the entire address. 

e. Copy the address (by choosing Edit > Copy or pressing Ctrl-C) 

f. In the task bar at the very bottom of the screen, click on tab that represents the Bb window. 

g. Click your mouse in the "URL" box, then paste the web address there (by choosing Edit > 
Paste or pressing Ctrl-V). 

 

(continued on next page) 
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5. In the "Description" box, you can type a brief annotation that describes the site 
(optional).   

6. In section 2, you could attach a document. (The need for this is rare.) 

7. RECOMMENDED:  Scroll down to section 3 and choose YES beside the second 
question: 

 

8. Scroll down to the bottom and click SUBMIT. 

9. You will see a "receipt" that lets you know the link was added.  Click OK.   
 
 
In the bread crumb trail, click on your course title to go to the "student view". Then 
click on "External Links" to see how the link displays to students. Then click the 
link to make sure it works!   
 
If you followed the recommendation in item 8 above, you will notice that the link will open 
in a separate window. You (or your students) can then maximize this window (if needed) 
and surf around as much as you want. When you are ready to return to Bb, simply exit 
this window (click X in the upper right corner) and you are back in Blackboard, right where 
you left off! 
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STEP 5:  Post instructor contact information (REQUIRED) 

 
The easiest part yet… 
 
Follow these steps to post your contact information in Blackboard: 

1. In the Control Panel, click on "Staff Information" (which is on the left, down towards 
the middle). 

2. In the tool bar, click "Add Profile"  (NOT "Add Folder") 

3. In section 1, simply fill in the blanks!  (You can skip any that do not apply to you.) 

4. At the bottom of section 1, in the "Notes" area, you can include a note to your students 
(optional).   

Posting a note here is can be a good way to add a personal touch to your course.  You can include 
something about your background, experience or training; your interest in the subject matter; your 
hobbies; etc. Some instructors have been quite creative with this!  

5. In section 2, you can attach a photo or include a link to a personal web site (optional). 

Note: If you choose to attach a photo, be sure to resize it first in a photo editing program and save it.  
Recommended size is 150 x 150 pixels, but a similar or slightly larger size is OK too. 

6. Scroll down to the bottom and click SUBMIT, then click OK.   
 
In the bread crumb trail, click on your course title to go to the "student view".  Then 
click on "Faculty Information" to see how it displays to students.   
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STEP 6:  Make folders and put content inside (Strongly recommended for online and hybrid) 

 
If you're teaching an online or hybrid class, it is especially important to learn how to make 
folders in Blackboard to organize course content.  (This can be good to know if you are 
teaching a "traditional" course as well.) 
 
Under the "Assignments" menu area in online and hybrid courses, most instructors make 
a separate folder for each week of the course.  For example: 
 

 
 
 
 
Inside each folder, the 
instructor puts details about 
that week's assignments, 
along with resources students 
will need to complete them.   
 
For example, on the right is 
the list of assignments 
students see when they click 
on the "Week 12" folder 
above. 
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To create a folder: 

1. In the Control Panel, click on "Assignments" (in the upper left area). 

2. In the "Add" tool bar at the top, click on "Folder". 

3. Enter a title (or name) for the folder. Type in a name like "Week One": 
 

 
 
4. In the text box, you can type in a VERY brief note about what can be found inside the 

folder, if you want (optional).  This is NOT where you put the content that goes inside 
the folder (that comes later). 

 

5. For now, skip over all other options on this page. (More on that later.) Scroll down to 
the bottom and click SUBMIT.  Then click OK. 

Now that you've created a folder, you need to put some "items" of content inside it.  
These "items" could provide details about… 

� Reading assignments for this week 
� Worksheets or problem sets for the student to complete 
� Description of an essay or report the student must write 
� Links to web sites relevant to the week's topic 
� Handouts or PowerPoint presentations that relate to the week's lesson 
� And so on… the possibilities are almost endless. 

 
For now, we will add one content item inside the folder about a reading assignment. (Feel 
free to add something different if you want.) 
 
 

type your folder name here! 
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To add a content item INSIDE the folder: 

1. Click on the folder title to go inside the folder.   

IMPORTANT:  This is a critical step, and many people mess up here!!   

To verify that you are inside the folder, look at the "bread crumb trail" at the top of 
the screen.  Reading from the right, it shows that you are in the "Week One" folder, 
which is in the "Assignments" area, which is in the "Control Panel", etc.   

 

Also, just below the bread crumb trail, the name of the folder you are in is 
displayed. 
 

2. In the "Add" tool bar, click on "Item".  Then enter a name and detailed description for a 
particular assignment.  For example: 

 
 
3. Scroll to the bottom and click SUBMIT, then click OK. 

4. In the bread crumb trail, click on the title of your course to return to the "student view" 
of things.  Then click on "Assignments" to see the folder you made, and click on that 
folder's title to see the item you made inside it. 

 
You can continue creating additional items, for additional assignments, inside the "Week 
One" folder.  To do this, remember to… 

o Go to the Control Panel. 
o Click on Assignments. 
o IMPORTANT:  Click on the "Week One" folder to go inside it. 
o On the "Add" tool bar, click "Item" and begin entering the next assignment… 

 
Also, you can continue creating folders, one for each week of the course, and fill each 
folder with assignment items. 
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FOLDER TIPS: 
 
� After you have created more than one folder, you can 

change the number to the left of the folder name to select 
the order in which the folder is displayed. 

By default, when you create a new folder (or item), 
Blackboard places it at the bottom---below any existing folders or items.  We 
recommend that you change the number beside the current week's folder to "1", so it 
will be listed at the top of the "Assignments" area (so students can't miss it!). 
 

� If you want, you can create folders in advance but make them "not available" to 
students for now. 

When a folder is "not available", the folder AND its contents are invisible to students, 
but still visible to instructors in the Control Panel.  When the time comes, you can make 
the folder available (or visible) to students. 
 
To make a folder invisible/visible to students: 

1. Locate the folder in the Control Panel.   

2. Click on "Modify" to the right of the folder. 

3. Scroll down to section 2. 

4. There are two ways to hide/unhide the folder.  Choose one: 

o Manually:  Click NO beside the question "Make folder available" to hide it from 
students.  Later, when you want to "unhide" it, return here and choose YES. 

o Automatically:  You can select a date/time for a folder to automatically become visible 
to students.  To do this… 

� Be sure to answer YES to the first question ("Make the folder available") 

� Then, check the box beside "Display After" and specify the date/time you want the 
folder (and its contents) to become visible to students.  The folder will be hidden 
until then. 

� You can also set a date/time for the folder to disappear again ("Display until"), but 
this is generally NOT recommended. 

After you've made a folder invisible, you will notice that its icon is "grayed out" in the 
Control Panel and that the folder is marked with this message: "Item is not available",
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STEP 7:  Post an announcement (REQUIRED) 

 
The announcements page is the first thing your students see when they enter your 
course.  Here, you can post lists of class activities for the week, reminders of upcoming 
tests or projects, changes to the syllabus, or info about campus events. 
 
It is important for the instructor to post a new announcement at least once a week, so 
students will know that the instructor is alive and involved in the Blackboard course! 
 
Follow these steps to post an announcement in Blackboard: 

1. In the Control Panel, click on "Announcements" (on the left, in the "Course Tools" 
section). 

2. Click "Add Announcement"    

3. Type in a subject and message (much like writing an email). 

4. Skip over the options in sections 2 and 3 for now.  (You almost never need to use 
these!)   

5. Scroll down and click Submit, then click OK. 
 
That's it!  Your announcement is now posted! 
 
In the bread crumb trail, click on your course title to go to the "student view" of the 
course.  You should see your new announcement, front and center. 
 
 

 
Notes about how announcements display to students 
 
When students enter a Blackboard course, they see announcements that were posted 
within the last 7 days.  The newest announcements are at the top, older ones below. 
 

Example:   
� If the student logs in on Oct 10, he will see announcements that were posted 

between Oct 3 and 10.    
� If he logs in again on Oct 14, he will see announcements that were posted 

between Oct 7 and 14. 

 
Students can view announcements that are more than 7 days old by clicking the tabs at 
the top of the Announcements screen. 
 
 
 

 
 
If you want to know more about the options we skipped over (in item 5 above),  
continue on to the next page… 
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Announcement Options 
 
Almost always, you'll just follow the 5 steps listed above to post an announcement.   
 
Below is information about additional options for announcements, in case you need to use them.  
We recommend that you use these options sparingly (if at all). 
 
To view the announcement options again: 
 
1. In the Control Panel, click "Announcements". 
 
2. Click "Modify" to the right of any existing announcement.  This will re-display the screen where 

you originally entered the announcement. 
 
3. Scroll down to section 2.  You will see these options: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. In section 3, you can create a link directly to an area of your course—for example, to 
the Discussion Board or to your Syllabus.  The link will display just below the text of 
your announcement.   

 
Example:  If your announcement tells students to post a message in the Discussion 
Board, then you could use this feature to include a link to the Discussion Board in your 
announcement.  (This feature is not often used!)  
 

5. Click Submit to save any changes (or Cancel to exit without saving). 

If you choose Yes here, this announcement will 
ALWAYS show at the top of the announcements 
page—that is, it will not "age out" after 7 days (as 
described above).   

If you choose this option, keep in mind that 
NEWER announcements you post will display 
BELOW this announcement. 

If you check the "Display After" box, 
the announcement will not be visible to 
students until AFTER the date/time 
you select. 

If you check the "Display Until" box, 
the announcement will disappear 
completely (from the students' view) on 
the date/time you select.  The 
announcement will no longer be visible 
on the main announcements page OR 
under the "Show All" tab. 
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STEP 8:  Customize your course menu (REQUIRED) 

 
In a new Blackboard course, the course menu looks like this.   
 
The menu item names are very generic—for example:  "Course 
Information" and "Course Documents" and "Assignments".  These 
vague names can leave students confused about where to find 
what in the course. 
 
It's a good idea to change the menu item names to something  
more specific and descriptive.  For example, instead of "Course 
Documents", you might rename this area "Handouts", "Lecture 
Notes", "Presentations", "Labs"---or whatever best describes what 
you will be using it for. 
 
In addition to changing the names of menu items, you can delete items you do not need 
and rearrange the order of items. (And later, you'll learn how to change colors too!) 
 
Before you get started: 

� Look at your course menu and think about what changes you want to make--- 
names you want to change, menu items you don't need, etc. 

� The steps below walk you through changing the name of the "External Links" area to 
"Web Sites". 

 
Follow these steps to begin customizing your course menu: 

1. In the Control Panel, click on "Manage Course Menu" (way down in the lower left 
area).  You will see a listing of your current menu items. 

2. Scroll down until you can see the "External Links" item.  Click "Modify" to the right of 
this item to begin editing it.     

3. You could use the drop-down menu to choose a different name.  However, I usually 
just go straight to the box below and type in the name I want.   

4. For this example, delete the text in the 2nd box and type in "Web Sites" (without quotes). 

IMPORTANT:  Avoid using LONG names!!  If your menu item names are too long (for example: 
PowerPoint Presentations), the course menu may display in very oddly on some computers.   

The recommended maximum length for a menu name is 18 characters. This is just a guideline, 
since all characters are not the same width.  As a rule-of-thumb, I try to make sure my menu item 
names are no longer than the space it takes to display the words "Course Information". 

5. Leave the "guest" and "availability" options as is.  Scroll down and click Submit to 
save your change, then click OK. 

 
Repeat the steps above to change the names of other menu items.   
 
As always, when you finish making changes, be sure to look at your course from 
the "student view" to make sure it looks OK. 

 



Building Your Course in Blackboard  Step 8: Customize the menu
   

December 2008  Page 20 of 24 

Notes about removing/adding menu items 
 
� Under "Manage Course Menu", you can click REMOVE to the right of any menu item 

to get rid of it.  We recommend that you remove menu items you don't plan to use.   
But be careful!  If you remove an item that has content in it, you will lose that content 
and cannot get it back! 

 
� At the top of the "Manage Course Menu" area is a tool bar that lets you add additional 

items to your course menu: 

 
o Content Area – lets you add another menu item for posting documents, text, 

PowerPoints, and other similar content 

o Tool Link – lets you add a specialized tool to the menu, such as a tool that lets 
students check their grades ("My Grades") 

o Course Link – lets you add a link to a specific area of your course (you'll never use 
this!) 

o External Link – lets you add an item to your main course menu that links to an 
external web site. (Example:  If your text book has a web site that students will 
need to visit often, you can add a link to it on your menu.) 

 
 

 
For inspiration, below are a few examples of ways instructors have customized 
their course menus: 
 

 
Biology class 

 

 
Computer class 

 

 
Spanish class 

 
Math class 
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By now, I am sure you are wondering: 
 

"How do I change the color and style of my course menu?" 
 
 
Follow these steps to customize the style and color of your menu: 

1. In the Control Panel, go to the Course Options area (way down in the bottom left 
corner). 

2. Click "Course Design" (2nd option from the top). You will see the following categories: 

• Course Menu Design (Change your course buttons or menu text) 

• Manage Menu Display Options (Detail vs. Quick View) 

• Manage Tool Panel (Tool options for Detail or Quick View) 

• Course Banner (Add a banner to your course) 

3. Choose Course Menu Design to change your buttons or text 

4. In section 1, select your menu style:  Buttons or Text 

� If you choose Text, then in section 2, you can select the background color and text 
color you want (using the "pick" button beside each). 

� If you choose Buttons, then in section 2 you can select the following: 

o Button type – your buttons can be… 

o Solid 

o Patterned  

o Striped 

o Button shape – choose from rectangular, rounded corners or rounded ends  

o Button style – Click "gallery of buttons" to display all color choices on one 
screen. Click any sample button to select that color, or change the options 
at the top to view other styles. 

4. After you've selected your menu style and colors, click Submit to save the changes.  
 
 
And finally, be sure to go to the "student view" to see how things look! 

 
 



Building Your Course in Blackboard  Step 9: Prepare a course for student use 

December 2008  Page 22 of 24 

STEP 9:  Prepare a course for student access (REQUIRED) 
 
By completing steps 1 - 8, you've learned the basics of building a course site in Blackboard.  
However, your students cannot access the course you've built, because it is a "practice" course. 
 

In this step, you will learn important procedures for setting up your "real" course sites on 
Blackboard and for making them visible and accessible to your students.   
 

NOTE:  It is VERY important that you read and understand the procedures described here.  You 
will need to follow them each semester in order for your courses to be set up and for your 
students to have access to them! 
 

How do I get my "real" courses set up on Blackboard? 
 

Continuing Education Courses 
(Skip to Step 10 on Page 24) 

For information about setting up Continuing 
Education Blackboard courses, contact: 

Becky Roehrs 
roehrsb@durhamtech.edu 
919-536-7240, ext. 4408 

Adult Education and Basic Skills Courses 
(Skip to Step 10 on Page 24) 

For information about setting up Adult Education 
and Basic Skills Blackboard courses, contact: 

Ann Thrash 
thrasha@durhamtech.edu 
919-536-7218, ext. 3004 

 
Credit Courses  
Note: You do NOT have to do this step to complete the Blackboard training! 
Each semester, you must submit a "Blackboard Course Creation Request" to have your course 
site(s) created on Blackboard. You can do that now to set up your "real" courses if you are 
ready and have all of your course information available. You can come back when you are 
ready and will need to submit one course request form for each course site you want created on 
Blackboard. 
 

Follow these steps request course sites on Blackboard: 

1. Go to the online "Blackboard Course Creation Request" form: http://courses.durhamtech.edu/tools/  
 

2. Choose the type of course you want created: 

 

 

 

3. Fill out the form, providing the information requested and then submit. 

Note:  If you chose to copy content from your practice course, you will need to specify  
the following information under Step 3 on the form: 

 

 

 

 

 
Courses will be created within 1-3 days. You will receive an email when they are ready. 

Choose this if you want to 
copy content from your 
practice course into your 
"real course" 

Select current  
year and 
semester   

Select prefix and 
enter course number 
as shown here 

7 
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Durham Tech Blackboard Procedures 

All instructors who use Blackboard at Durham Tech are responsible for following the 

procedures. Please read carefully and completely! 

http://courses.durhamtech.edu/wiki/index.php/Tasks_to_do_each_semester 
 

This resource page will provide answers to the following questions: 

• When and how are my students added to my courses on Blackboard? 

• How do I make my courses visible to my students?  VERY IMPORTANT!! 

• Where do my students get instructions about how to log in?  VERY IMPORTANT! 

• What if a student cannot log in? 

• What if a student drops my course? 

 

 

Thank you for reading!  Now you are almost done with this workshop… 

The last step is to email us to let us know you are finished, so we can give you credit for 
completing the workshop.  Move on to Step 10 for final instructions. 
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STEP 10:  Email us! (REQUIRED) 
 

Congratulations! You have finished the basic course building tutorials and should now have the 
skills to continue adding content to your Blackboard course. 

 

How can I learn more about Blackboard? 

There are several ways you can continue expanding your Blackboard knowledge and skills: 

� Online help site for Blackboard 

Our Blackboard help site contains numerous tips, questions and answers for instructors and 
students who are using Blackboard:  http://courses.durhamtech.edu/wiki/ 

The Help for Instructors area contains many resources including:  

• Blackboard Help for Instructors: 
http://courses.durhamtech.edu/wiki/index.php/Blackboard_Help_for_Instructors 

� Blackboard Procedures: 
http://courses.durhamtech.edu/wiki/index.php/Tasks_to_do_each_semester 

� Blackboard Handouts: 
http://courses.durhamtech.edu/wiki/index.php/Bb7_Handouts 
 

� Training workshops 

Additional Blackboard workshops are offered on topics such as using the Blackboard's 
gradebook, building online tests, and using communication tools (including the Discussion 
Board). To see a list of upcoming workshops and to sign up, visit our training web site at this 
address:  http://courses.durhamtech.edu/training/  

Bb-announce mailing list 

Upon completion of this workshop, you will be subscribed to the "Bb-announce" email mailing list. 
This list is used to distribute important announcements about the Blackboard system.   

Please pay attention to any email messages you receive through this list! (Traffic is minimal.)  You 
will also receive a monthly email message reminding you that you are on the list. 
 
Thank you for participating in this workshop and for persevering until the end! We look forward to 
hearing from you soon. 

To receive credit for completing this workshop… 

You must email the workshop facilitator to tell us you’re finished.  We will look over 
your Blackboard course to verify that you've completed the required steps and then 
record your completion in our training database. 

Send an email to:  hortons@durhamtech.edu 

Subject:  Building a Basic Course in Blackboard Complete 

By notifying us you are finished with this workshop, you… 

verify that you have read, followed the directions, AND understand the information presented 
to you in each of the 10 steps of this workshop.  You completed all the required tasks in the 
workshop. You are aware AND understand that Durham Tech’s Blackboard procedures 
http://courses.durhamtech.edu/wiki/index.php/Tasks_to_do_each_semester 
must be followed in order to prepare and request courses each semester.  


